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INTRODUCTION TO HOPEX SUITE FOR 
TOGAF

HOPEX Suite for TOGAF is a software application created by MEGA International to assist:

• Project leaders to use the TOGAF 9 method.
• Method managers in a company to adapt the supplied components of the 

application to the company’s context.

It can be used to:

• Describe the sets of standard phases of the TOGAF 9 method.
• Attach to each method phase, the types of deliverables that can be 

generated, be it documents, analyses or diagrams.
• Build TOGAF 9 projects while at the same time creating instances of 

phases and deliverables. These instances can be modified for adaptation 
to different project contexts without there being any impact on the 
model itself or on any other project.

• Facilitate the implementation of project follow-up via the features of the 
HOPEX platform.

What is TOGAF 9?

The Open Group Architecture Framework (TOGAF) is an Enterprise Architecture
Modeling framework which provides a set of methods and tools for developing a
broad range of IT architectures. TOGAF 9 is a version that provides the methods and
tools to assist in the acceptance, production, use, and maintenance of an enterprise
architecture. It is based on an iterative process model supported by best practices
and a re-usable set of existing architecture assets.
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Introduction

TOGAF 9 uses the reliable and practical Architecture Development Method (ADM)
which provides a tested and repeatable process for developing architectures. This
method uses different phases which are quite helpful in:

• Defining business needs
• Developing architectures that meet to those needs
• Employing the TOGAF elements and the architectural assets available to 

the organization.

Project Managers and IT users of TOGAF are able to design, evaluate and build
architectures that meet the organization’s needs. The costs of planning, designing
and implementing architectures are therefore reduced.

Implementing the TOGAF 9 ADM in HOPEX

HOPEX Suite for TOGAF is the implementation of the TOGAF 9 framework in the
HOPEX Modeling Suite. 

This application assists you in creating projects via:
• The ADM method formalization
• The initialization of TOGAF 9 projects
• A continuous guide at the different stages of the project
• The ability to filter TOGAF phases, according to the current user role.

The TOGAF 9 ADM phases are as follows:
• The Preliminary Phase: this phase describes the preparation and 

initiation activities required for preparing to meet the business directive 
for a new enterprise architecture. This includes the definition of an 
Organization-Specific Architecture framework and the definition of 
principles.

• Phase A: Architecture Vision: this phase describes the initial phase of 
an architecture development cycle. It includes information about defining 
the scope, identifying the stakeholders, creating the Architecture Vision 
and obtaining approvals.

• Phase B: Business Architecture: this phase describes the 
development of a Business Architecture to support an Architecture Vision 
that has been agreed on.

• Phase C: Information Systems Architectures: this phase describes 
the development of Information Systems Architectures for an 
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architecture project, which includes the development of Data and 
Application Architectures.

• Phase D: Technology Architecture: this phase describes the 
development of the Technology Architecture for an architecture project.

• Phase E: Opportunities & Solutions: this phase conducts initial 
implementation planning and the identification of deliverables for the 
architecture defined in the previous phases.

• Phase F: Migration Planning: this phase addresses the formulation of 
a set of detailed sequence of transition architectures with a supporting 
Implementation and Migration Plan.

• Phase G: Implementation Governance: this phase provides an 
architectural oversight of the implementation.

• Phase H: Architecture Change Management: this phase establishes 
procedures for managing changes to the new architecture.

• Requirements Management: this phase examines the process of 
managing architecture requirements throughout the ADM.

MEGA’s implementation of the TOGAF 9 ADM extends over two different approaches
to using the HOPEX Suite for TOGAF tool:

• As a standard TOGAF implementation for using the TOGAF 
application as a stand-alone tool.

• As an extended MEGA implementation that supports ADM-guided 
projects combined with the HOPEX metamodel and diagrams.

Standard TOGAF implementation

With this approach, the metamodel provided to support the ADM is strictly and fully
compliant with the entire architecture content framework. All concepts, properties
and associations can be accessed with their native names. The HOPEX Suite for
TOGAF application can be used as a stand-alone tool, with no need for additional
applications to start architecture projects. TOGAF concepts can be used with their
native names.

The HOPEX Suite for TOGAF application is provided with a set of reports that are
generated from the created TOGAF concepts.
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New diagrams have also been delivered to support the TOGAF metamodel. These
new diagrams supply the content architecture framework, therefore, allowing the
creation of TOGAF concepts and associations.

List of diagrams and concepts proposed for the standard implementation of TOGAF

Extended TOGAF Implementation

With this approach, the ADM method is configured for using HOPEX templates to
implement expected deliverables. The proposed templates are dependent on the
availability of additional products, such as HOPEX Business Process Analysis,
HOPEX Architecture and HOPEX Planning.

This approach relies on the complete HOPEX metamodel which includes the HOPEX
Business Process Analysis and HOPEX Architecture metamodels. To be
consistent, the diagrams proposed in this context are those supplied by the
additional tools.
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Filtering Native TOGAF Deliverables

The means of providing native TOGAF deliverables, such as document templates,
diagrams, reports, etc. are provided by the HOPEX Suite for TOGAF application.
As such, when this application is combined with another complementary application
of the HOPEX Modeling Suite, the TOGAF tools as well as the extended set of tools
from the other applications are visible. To allow users to filter the type of tools
visible, an option has been added. By default, this option is checked, allowing users
to only have access to TOGAF tools. 

Prerequisites for Using HOPEX Suite for TOGAF

Before using the HOPEX Suite for TOGAF product, the HOPEX suite must be
installed. You must then:

• Create the users of the product
• Import the TOGAF 9 solution pack
• Import the Metamodel Customizations solution pack
• Configure access to the TOGAF 9 libraries

Creating the main users

HOPEX Suite for TOGAF is intended for two kind of user profiles: 
• The Method managers responsible for adapting the TOGAF 9 methods to 

the company’s needs
• The Project managers who use the method phases recommended by the 

method managers to carry out their projects.
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To create the different users for each profile:
1. In the HOPEX installation folder, start the administration tool 

Administration.exe.
2. Select the environment in which you want to work, for example, 

"Demonstration".
3. Log in with a user that has access rights to administer data, for example, 

"System".
4. Expand the environment and the User Accounts folders.
5. Right-click on Authorizations and select Open Diagram.

The authorizations diagram opens.
6. Use the Authorization icon in the object toolbar to create a "Method 

Manager" and a "Project Manager" authorization.
7. Link these authorizations to the "System" authorization.
8. Create the users for each profile.
9. Save and close the authorization diagram.

The diagram is automatically compiled.

Importing the TOGAF 9 - Data and Metamodel Customization Solution Packs

To access the TOGAF 8.1 and 9.0 components offered by HOPEX you must import
the TOGAF 9 - Data and TOGAF 9 - Metamodel Customizations.

The solution packs are delivered in the TOGAF.exe compressed file and must be
decompressed before they can be imported into a repository.

 TOGAF 9 - Sample is an example of a project created with the 
TOGAF 9 method. You can import this example for the purposes of this 
guide, however, it does not need to be imported for HOPEX Suite for 
TOGAF to function.
 You are encouraged to also import the HOPEX Architecture 
solution pack (in the mega.exe compressed file) which allows you to 
share common IT objects, such as artifacts, communication protocols 
and resource architectures. These objects are usually provided with the 
HOPEX Architecture product. This import is not mandatory.

To import a solution pack, see HOPEX Administration - Supervisor > Managing
Objects > Importing Reference Frameworks in MEGA > Importing a Solution Pack.

Metamodel Customizations

The HOPEX Modeling tool comes with its own set of concepts and vocabulary. To
minimize the differences between the names of concepts in this tool and in the
HOPEX Suite for TOGAF, the TOGAF 9 - Metamodel Customizations solution
pack can be imported into HOPEX that renames certain concepts using the TOGAF
vocabulary. This renaming is only done in English. It is advised to import the
metamodel customization file only if you want to strictly work with a TOGAF
metamodel. To retrieve the list of renamed terms, refer to the paragraph "MEGA
Metamodel Customizations", page 48.

Configuring access to TOGAF 9 libraries

The aim of this step is to define the rights of the different profile users on the library
objects imported.

 You should have previously imported the TOGAF 9 - Data 
framework and created the users and profiles.
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To define these rights:
1. Start the HOPEX application, MEGA.exe and log in with a user that has 

administration rights.
2. Select the Tools menu > Manage > Protect Objects.

The Object Protection dialog box appears.
3. Select the TOGAF library in the Objects section and the authorization 

profile in the "Authorizations" section, for example, "Method Manager". 
4. Click on Apply.

The confidentiality level changes.
5. If you have imported the TOGAF 9 - Sample framework, redo the steps 

above with the TOGAF 9 - Sample library and the "Project Manager" 
authorization.

6. Click Close .
7. Quit HOPEX by dispatching your transaction.

Additional Requirements

The HOPEX Modeling Suite offers the possibility of attaching objectives and
requirements to architecture objects as well as indicators that can be used to
determine to what extent objectives have been met. 

 See the HOPEX Common Features user guide for further 
information on objectives, requirements and indicators.

To ensure that objectives and requirements are displayed in the TOGAF 9 project,
activate the Objectives and requirements modeling option:

 Select Tools > Option > Business Process and Architecture 
Modeling > Objectives and requirements modeling.
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To ensure that indicators are visible in the project activate the Monitoring option.
 Select Tools > Option > Business Process and Architecture 

Modeling > Monitoring.

Discovering the TOGAF 9 navigation tree

The standard components provided by the TOGAF library of HOPEX Suite for
TOGAF can be accessed from the dedicated TOGAF 9 navigation window. These
components include the different TOGAF projects, the ADM methods, the TOGAF 9
dictionaries, etc.

To launch the TOGAF 9 navigation window:
 In the HOPEX menu bar, click View > Navigation Windows > 

TOGAF 9.
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The navigation window appears in the workspace.

By default, theTOGAF 9 navigation window displays the repository in which the
TOGAF 9 framework has been imported. 

It also displays other folders that are available for the framework.
 Expand any of the folders to see its content.

 If the TOGAF 9 - Data framework was not imported into the 
repository, the "TOGAF - 9 Dictionaries", "Technical Reference Model 
(TRM)", "Book Templates" and "TOGAF 9 Architecture Principles" folders 
will be empty.

• Projects
The Projects folder contains the TOGAF projects of the repository. Each
project is created with a "Contents" folder which contains the architecture
objects that are attached to the particular project.
Each TOGAF project contains a first set of sub-projects that are linked to
the phases of the method used for the project.

• ADM Methods
This folder displays all the ADM methods available in the repository. This
includes the ADM method imported with the TOGAF 9 data add-on as well
as any other variant of this method created for use in the repository. The
system diagram as well as the phases for each method is also displayed.
Each phase is displayed with its system diagram, the required deliverables
of the phase as well as the steps to be followed to complete the phase.

• Dictionaries
This folder contains the different components of the TOGAF 9 dictionaries
which include the abbreviations of terms, as well as terms and their
definitions that can be attached to objects of the repository.

• Technical Reference model (TRM)
This folder contains the City plan that represents the Technical reference
model used to provide the model and taxonomy of generic IT platform
services.

• Book Templates
This folder contains the book templates used to create deliverables in the
form of books. The different components of each book are also displayed,
for example, chapters, paragraphs, diagrams, analyses, etc.

• Architecture Principles
This folder includes the different principles that apply to the TOGAF
architecture. These principles represent different objectives that should
be met by the architecture.
The principles are divided into seven categories: Application, Business,
Data, Guiding, Integration, Security, Technology.
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PRESENTATION OF THIS GUIDE

This guide introduces the basic features of HOPEX Suite for TOGAF. This
application is intended for two kind of users: Method and Project managers.

The user guide successively presents:
• The HOPEX workspace
• The basic methodological components of the application and the different 

customization possibilities provided 
• Step-by-step procedure on how to create a project that complies with 

the method recommended by TOGAF
• How to generate and access the different deliverable products

Conventions Used in the Guide

 Remark on the preceding points.

 Definition of terms used in this guide.

 A tip that may simplify things.

Commands are presented in this way: File > Open.

The names of HOPEX products and technical modules are presented in this way:
HOPEX.
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PRESENTATION OF THE CONCEPTS

This chapter introduces the basic components delivered with HOPEX Suite for TOGAF for
implementing the TOGAF 9 methodology in an operational project. These components are based on
the features of the HOPEX platform.

The following are successively presented:

 "The HOPEX Suite for TOGAF ADM Method", page 12
 "The Technical Reference Model (TRM)", page 15
 "The TOGAF 9 Metamodel", page 18
 "The TOGAF 9 Dictionaries", page 20
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THE HOPEX SUITE FOR TOGAF ADM METHOD

TOGAF proposes, with the ADM (Architecture Development Method) a cyclic process
for architecture development. 

HOPEX proposes features that can facilitate the modeling of projects on processes
and enterprise architectures, while particularly using the MEGA Open Kit Approach
(MOKA) capacities to do this. As such, each project can be created from methods
that describe the phases for project implementation.

 A method represents a series of actions carried out to achieve a 
goal. A method is described by a series of phases.

 A phase is an operational activity that participates in production of 
the deliverables of the approach. It can be an activity related to 
production, verification, delivery, etc.

Discovering the MOKA Framework

With MOKA (HOPEX Open Kit Approach), HOPEX proposes a framework for method
formalization. MOKA allows you to describe the sequence of your projects (of
organization, architecture, integration or application development).

MOKA is a project management structure managed in the HOPEX repository. It
allows you to equip your approach using definition of methods, phases and
deliverables. 

A project can be considered as the implementation in HOPEX of a MOKA method.
Sub-projects are aligned with method phases.

 A method represents a series of actions carried out to achieve a 
goal. A method is described by a series of phases.

 A phase is an operational activity that participates in production of 
the deliverables of the approach. It can be an activity related to 
production, verification, delivery, etc.

 A deliverable is an element produced, modified or used by a phase 
or method (example:

In this context, HOPEX allows you to easily initiate a project by providing
indications at each stage of its progression. 

Discovering the Representation of the ADM Method

HOPEX integrates the TOGAF Architecture Development Method (ADM) in order to
describe the sequence of projects (of organization, architecture, integration or
application development).

HOPEX allows you to equip your approach through the definition of methods,
phases, and deliverables. As such, with HOPEX Suite for TOGAF, a project can be
initialized as the implementation of the ADM method. The sub-projects are linked to
the method phases.
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In this context, HOPEX Suite for TOGAF allows you to easily initiate a project by
providing indications at each stage of its progression. 

A phase scheduling diagram describes the sequence of the different phases of a
method.

Accessing diagrams 

To access the diagram that describes a method:
1. In the TOGAF 9 navigation window, expand the ADM Methods folder.
2. Right-click the desired method, for example, TOGAF 9 ADM and in its 

pop-up menu select Phase Scheduling Diagram.
The phase scheduling diagram appears.

"TOGAF 9 ADM" Method Phase Scheduling Diagram

It presents the sequencing order of phases and the deliverables expected at input
and output of each of these phases. 



14 HOPEX for TOGAF

1

To access the diagram that describes a method linked to a phase:
 Double-click a phase, for example, Preliminary Phase.

The phase scheduling diagram of the phase appears.

In the above example, the first phase of the method is "Scope the Enterprise
Organizations Impacted" and the input deliverables of this "Preliminary Phase" are
"Board Strategy", "IT Strategy" or "Architecture Principles".

 A phase scheduling diagram can be represented in standard 
notation or in BPMN notation, depending on the Method Graphical 
Notation defined in the Characteristics tab of a method. 
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THE TECHNICAL REFERENCE MODEL (TRM)

The Technical Reference Model (TRM) provides a model and taxonomy of generic IT
platform services. It is a foundation on which more specific architectures and
architectural components can be built. Based on the Integrated Information
Infrastructure Reference Model (III-RM), the main use of such a reference model is
to provide terminology and a checklist.

In HOPEX Suite for TOGAF, the TRM is implemented via the "City Planning"
concept available in HOPEX Architecture. 

 For more details on HOPEX features, see the HOPEX 
Architecture and HOPEX Planning user guides.

Understanding the City Planning Notion

City planning consists of grouping the different applications used in the information
system into "city planning blocks" of similar functionality.

Several strategies for creating these groups can be defined. It is therefore possible
to define several city plans that describe the information system from different
points of view.

 City planning is the splitting of the information system according to 
a particular criterion. This splitting can be by main enterprise functions, 
by origin of applications as the result of a merger, by type of system 
environment or by any other criterion pertinent to the context of the 
enterprise.

The information system processing is broken down into different levels:
• Area 

This is the highest level in the breakdown of the enterprise information
system. For most companies, there is a data acquisition area, an
information processing area, a management area, a repository area, etc.

• District
The district groups the processing that can correspond to an activity or a
business function, and therefore to a type of information.

• Block
The block corresponds to the basic component of the city plan. A block is
a homogeneous set of data and processings. Computer applications are
grouped within the city planning blocks.

• Etc.
 Additional levels can be specified if required.
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Accessing the Technical Reference Model (TRM)

Accessing TRM diagrams

The two diagrams below describe two implementation levels of the TRM. To access
these diagrams:

1. In the TOGAF 9 navigation window, expand the Technical Reference 
Model (TRM) folder.

2. Right-click the Technical Reference Model and in its pop-up menu 
select the City Planning Zoning Diagram.

3. From the list displayed, select the Technical Reference Model 
(MEGA::TOGAF) - Detailed View and click OK to open the diagram.
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Areas and sub-areas

"Sub-areas" can be created from an area, regardless the city planning level ("area",
"district" or "block"). 

• When you create a Sub-area from an "Area", the sub-area automatically 
becomes a "District".

• When you create a Sub-area from a "District", the sub-area 
automatically becomes a "Block".

 The appearance of the area changes according its city planning 
level.
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THE TOGAF 9 METAMODEL

The graphical user interface provided with HOPEX Suite for TOGAF is based on the
TOGAF metamodel. In order to match TOGAF concepts with HOPEX metaclasses,
the TOGAF metamodel is entirely based on HOPEX abstract metaclasses.

 For more details on HOPEX facilities, see the Studio user guide.

Metamodel Concepts

Metamodel definition commands concern object types (MetaClasses), the links
possible between these object types (MetaAssociations), the two ends of each of
these links (MetaAssociationEnds) and the characteristics (MegaAttributes). Object
comments are treated like characteristics of object types.

Accessing the TOGAF Metamodel

To access the TOGAF 9 Metamodel diagram:
1. Check that you have "Advanced" access rights to the metamodel 

(Tools > Options, Repository > Metamodel Access > Advanced).
2. In the MetaStudio navigation window, expand the MetaModel.
3. Expand the MEGA Modeling and TOGAF 9 Metamodel folders.
4. Right-click Full Metamodel and in the pop-up menu select MetaModel 

Diagram.

Concepts Syntax

object type MetaClass

link MetaAssociation

leg MetaAssociationEnd

link type MetaAssociationType

characteristic MetaAttribute

characteristic grouping MetaAttributeGroup

characteristic value MetaAttributeValue



19

Presentation of the Concepts
The TOGAF 9 Metamodel

5. Select Full MetaModel::TOGAF 9 Full Metamodel and click OK.
The metamodel diagram opens. It describes the metamodel instances.

Full Metamodel Diagram for TOGAF 9 

Graphical descriptions of other metamodels exist with details of the complete
implementation of the TOGAF 9 metamodel in the HOPEX repository.
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THE TOGAF 9 DICTIONARIES

Three dictionaries are provided with the HOPEX Suite for TOGAF framework to
ensure that the user can benefit from a shared and agreed-on vocabulary. The
definitions of these dictionaries come from the TOGAF 9 framework.

To access the elements of the TOGAF 9 dictionaries:
1. In the TOGAF 9 navigation window expand the Dictionaries folder.

Three folders corresponding to the different dictionary components
appear.

2. Expand any of the three dictionary components folder, for example, 
TOGAF 9 Definitions, to view the list of terms (or abbreviations) 
provided.

• The TOGAF 9 Abbreviations folder contains the abbreviations of terms 
contained in the dictionaries. The term corresponding to the abbreviation 
is displayed in the Properties dialog box of the abbreviation, 
Characteristics tab.

• The TOGAF 9 Definitions and TOGAF 9 Supplementary Definitions 
folders contain terms and definitions that can be attached to elements of 
the architecture. The definition text of terms is located in the Properties 
dialog box of the term, Characteristics tab

 For more details on how to use the dictionary, see the HOPEX 
Common Features user guide, "Using the Dictionary" paragraph.
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PERSONALIZING THE TOGAF 9 METHOD

The HOPEX Suite for TOGAF framework uses a formalization of the ADM method. The HOPEX
platform offers a set of standard features that allows users to personalize the components of the
standard method. 

This chapter introduces the procedures for:
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DUPLICATING A METHOD

In order to keep the components of the method delivered as standard with HOPEX
Suite for TOGAF the HOPEX platform offers features that can be used to duplicate
a method by creating variants of it.

When duplicating a method it is best to do so from the library containing the method
in question to avoid access right problems. 

 You must have the Studio or the HOPEX Administration - 
Supervisor module to be able to duplicate a library.

Once duplicated the method and all the related items (phases, sub-methods,
deliverables) are linked to the original source via a traceability link. This link is used
to ensure that the new method is based on the TOGAF 9 ADM method and this new
method will be proposed during the creation of new projects from the TOGAF 9
navigation window (see "Creating Work Packages with TOGAF 9 ADM", page 32).

To duplicate a method:
1. Open the MetaStudio navigation window (View > Navigation 

Windows > MetaStudio).
2. Expand the System Library folder and the MEGA library.
3. Right-click the TOGAF 9 library and in the pop-up menu that appears 

select Duplicate.
The duplication dialog box appears.

4. Enter the Name of the duplicate library and click Ok.
5. When the duplication process is complete, expand the duplicate library 

and rename its TOGAF 9 ADM method.

Both TOGAF 9 ADM methods are now displayed and accessible in the TOGAF 9
navigation window. 
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CUSTOMIZING THE COMPONENTS OF A METHOD

A method is described by a series of phases. These phases are the operational
activities that are performed in order to produce the different deliverables of the
method.

 A phase is an operational activity that participates in production of 
the deliverables of the approach. It can be an activity related to 
production, verification, delivery, etc.

Phases can be customized.

Phase properties

From the properties dialog box of a phase, you can specify important information
on project implementation.

To access the properties of a phase:
1. In the Methodology or TOGAF 9 navigation window, expand a method.

Example of a method

2. Right-click the desired phase and select Properties.
3. In the properties dialog box that opens, select the Characteristics tab.

In this tab you can indicate:
• The Phase Type (for example, "Production"), as well as the Optional 

phase.
• An Implementing Method list, which is the list of implementation 

methods for this phase suggested to the project manager during 
project createion.

 You can, for example, view the list of methods implemented in the 
"Business Process Mapping" phase. For more details on phase splitting, 
see "Specifying phase composition", page 26.

4. Select the Details tab to specify the list of sub-phases that make up the 
phase.

 For more details on phase splitting, see "Specifying phase 
composition", page 26.
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5. Select the Resources tab to specify the list of resources required to 
execute the phase.

6. Select the Deliverables tab to specify the list of deliverables used and 
produced in the phase.

Phase resource type

In HOPEX, phase resources can be of different types: "Skill", "Software",
"Documentation" or "Training", for example.

To specify a phase resource type:
1. Open the properties dialog box of the phase and select the Resources 

tab.
The list of resources required for executing the phase is displayed.

2. Right-click a resource and open its properties dialog box.
3. Select the Characteristics tab and select the Resource Type.
4. Click OK.

Deliverable properties

A deliverable is an element that is expected at the input or output of a phase. In
HOPEX, these deliverables can be supported by different types of tools: Analysis
Template, Document Template, Book, Diagram or External Reference.

 A deliverable is an element produced, modified or used by a phase 
or method (example:

To determine the list of components of a deliverable: 
1. Right-click the deliverable and select Properties.
2. In the properties dialog box, select the Templates tab to view the list of 

elements associated with the deliverable.
 The list of deliverables expected at phase input or output is 
accessed from the Deliverables tab of the phase properties dialog box. 
For more details on phase properties, see "Phase properties", page 23.
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CUSTOMIZING PHASE SEQUENCE

Creating a method from the navigation tree

To create a method from the navigation tree:
 A method represents a series of actions carried out to achieve a 
goal. A method is described by a series of phases.

1. In the Methodology navigation window, right-click the Methods folder 
and select New > Method.

 The "Methods" folder contains all the methods included in the 
repository.

The Creation of Method dialog box appears.
2. Enter the Name of the new method.
3. Click OK.

The method is created and added to the list of methods.

A method is described in a phase scheduling diagram, but also through links
between phases, through deliverables and through resources.

 A phase is an operational activity that participates in production of 
the deliverables of the approach. It can be an activity related to 
production, verification, delivery, etc.

 A deliverable is an element produced, modified or used by a phase 
or method (example:

Creating a phase in a method

You can create a phase in a method from in a navigation window:
 In the Methodology or TOGAF 9 navigation window, right-click the 

method concerned and select New > Phase.

You can also create phases in a method from the scheduling diagram of a method.

To create a phase in a method from the scheduling diagram of the method:
1. Depending on the type of phase you want to create, click one of the 

following buttons in the objects toolbar: Begin , Production , 

End , Verification, Delivery or Milestone.
2. Holding down the mouse button, click in the diagram workarea.

The Creation of ... dialog box for creating the phase appears.
3. Enter the name of the phase and click OK.

Links between phases

In a method scheduling diagram, you can easily link different phases.

To link phases:

1. In the objects toolbar, click 
2. Click the first phase and, holding down the mouse button, draw a line to 

the second phase.
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3. Release the mouse button.
 If the "Sub-Phases" view is activated, an intermediate dialog box 
appears in which you are asked to select a link type. For more details, 
see "Specifying phase composition", page 26.

Specifying phase composition

To specify phase composition:
1. Select the View menu > Views and Details. 
2. In the dialog box that appears, select the Sub-phases check box, then 

click OK.
3. Draw a link between two phases.

The Create link dialog box appears.

It offers a choice between a "Next Phase" link which indicates a sequence
between two phases, and a "Sub-Phase" link which indicates that one
phase is subset of the other.

4. Select the "Sub-Phase" link. A dotted arrow line is displayed between the 
two phases.

 The list of sub-phases of a phase is accessed from the Details tab 
of the phase properties dialog box.
 For more details on project creation from a method, see "Creating 
Work Packages with TOGAF 9 ADM", page 32.

Adding a participant to a method

To graphically specify the participants in phase implementation, you can insert
participants in the diagram.

To create a participant:

1. Click the Participant  button in the objects toolbar.
The participant appears in the diagram.

2. Click the name "System Participant", press key <F2> and change the 
name of the participant.

To assign a phase to a participant:
 Position a phase within the frame of the participant.

The frame of the participant is highlighted. 
 When positioned, the phase is connected to the participant, which 
indicates that this participant executes this phase.
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HOPEX SUITE FOR TOGAF WORK 
PACKAGES

This chapter presents the basic features of HOPEX Suite for TOGAF to implement the TOGAF 9
ADM methodology in an operational project.

Herein you will learn how to:

 "Viewing a TOGAF 9 Work Package", page 28
 "Creating Work Packages with TOGAF 9 ADM", page 32
 "Creating TOGAF 9 Work Package Documentation", page 35



28 HOPEX for TOGAF

3

VIEWING A TOGAF 9 WORK PACKAGE

Work Package Scheduling Diagrams

The Scheduling Diagram allows you to describe the sequencing of your organization,
architecture, integration or development projects in conjunction with a TOGAF 9
framework.

A project scheduling diagram shows the sequencing of the different phases of a
project, or of the sequential linking of projects between themselves.

 A project consists of a set of tasks entrusted to a team, which 
transforms a system or part of a system with the aim of achieving a 
given objective.

To access the diagram that describes a project:
 In the TOGAF navigation window, expand the Projects folder and right-

click the TOGAF Work Package you wish to navigate
 select Scheduling Diagram.

 You must have imported the TOGAF 9 - Sample add-on provided 
with the TOGAF 9 framework. For more details, see "Importing the 
TOGAF 9 - Data and Metamodel Customization Solution Packs", page 6.
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The work package scheduling diagram appears presenting the various phases of the
work package.

Work Package Characteristics

To open the properties dialog box of a work package:
 Right-click the work package and select Properties.
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To specify the characteristics of a work package:
 In its properties dialog box, select the Characteristics tab.

You can change the Name of the work package,
• the  Project Type to which the method corresponds, and the Method 

selected for its implementation.
 For more details on project types and methods, see "Duplicating a 
Method", page 22.

 A project type defines project typology such as description of a 
business process, mapping or development of applications, etc. A 
project type can be implemented using one or several methods.

 A method represents a series of actions carried out to achieve a 
goal. A method is described by a series of phases.

 A phase is an operational activity that participates in production of 
the deliverables of the approach. It can be an activity related to 
production, verification, delivery, etc.

You can specify:
• The Workload necessary for implementing the work package and its 

Progress Percentage.

Work Package Participants

In the Participants tab accessed in the work package properties dialog box, you
can specify information concerning the participants of the work package.

There are three types of participant:
• Org-unit

 An org-unit is an element of the enterprise structure such as a 
department, a service, or a workstation. An internal organization unit is 
defined based on how detailed you require your view of the enterprise 
to be. Example: financial management, sales management, marketing 
department, account manager. An external org-unit is an external entity 
that exchanges flows with the enterprise. Example: customer, supplier, 
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government office.
• Person

 A person holds a position in an organization. It is designated by its 
name. Example: Mr. Smith.

• User
 A user is authorized to access certain functions of the product and 
certain repositories. Each user has a specific desktop in each database, 
and can connect to this desktop from any workstation in a given 
environment. The code associated with the user is used to generate file 
names as well as a specific work folder for the user. At the time of 
installation, two users are automatically created: a user identified by 
the name you entered, and the "Administrator" user, which is used to 
manage repositories and create new users.
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CREATING WORK PACKAGES WITH TOGAF 9 ADM

Creating a TOGAF 9 Work Package

Using elements described in HOPEX Suite for TOGAF you have available a project
creation wizard that allows you to automatically initialize the structure of your
project from the TOGAF 9 ADM method: steps, associated resources and
deliverables to be produced.

This wizard can be of particular value for deployment of projects in your enterprise.

To benefit from assistance to create your work package:
1. Start creating a work package.

The work package creation wizard starts. This wizard helps you create the
project menu tree and a project scheduling diagram. It links the project
and its sub-projects to the corresponding methods and phases.

2. Indicate a Name for the work package.
3. If you have several methods, select the method on which the project is 

based from the list displayed. If only one method is available the work 
package is automtically based on this method. 

 This list is restricted in accordance with the previously selected 
project type.

4. Click Finish.
The wizard creates as many sub-projects as there are phases in the
selected method. If a phase is supported by just one method, the sub-
project structure is also created.
For each phase supported by several methods, the wizard automatically
proposes the selection of possible methods.
When the work package has been created, it contains as many sub-
projects as there are phases in the method.

Modifying a Work Package Scheduling Diagram

You can modify the content of a work package created with the ADM method without
there being any impact on the method itself.

Creating a work package in a diagram

To create a work package in a diagram:

1. In the objects tool bar, click the Work Package button 
2. Then click in the diagram workarea.

The Add Work Package dialog box appears.
3. Enter the name of the work package and click the Create button.

The Creation of Work Package dialog box appears.
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4. Click Finish, if you do not want to base your work package on a project 
type or a method.

 Several objects can be given the same size. To do so, select the 
objects by holding down the <Shift> button and applying one of the 
options under Drawing > Make Same Size. You can also align these 
objects with the Drawing > Align command (the last object selected is 
the reference on which the alignment is based).

To create a new work package diagram:
1. Right-click a work package and select New > Diagram.
2. In the wizard that opens, select Scheduling Diagram and click the 

Create button.
An empty diagram appears.

Interconnecting Work Packages

In a scheduling diagram, you can easily interconnect different work packages.

To connect work packages (or projects):

1. In the objects toolbar, click 
2. Click on the first project and, keeping the mouse button pressed down, 

draw a line to the second.

 If the "Composition" view is activated, an intermediate dialog box 
appears in which you are asked to select a link type. For more details, 
see "Specifying work package composition", page 34.

The direction of the link is important. In the case above, the link indicates that
"Project 1" precedes "Project 2".

If you drew the arrow in the wrong direction, you must delete the link and redraw
it in the correct direction.

To delete the link:
1. Right-click on the link.
2. In the pop-up menu that appears, select Delete.

Creating a work package by linking it with other work packages

To create a work package while linking it with two other work packages:

1. In the objects toolbar, click the Work Package button 
2. Click on the first work package and, keeping the mouse button pressed 

down, draw a line to the second.

The Add Work Package dialog box appears.
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3. Add the name of the new work package and click Create.
4. In the work package creation dialog box that appears verify the name of 

the project and click Finish if you do not wish to specify the project type.

The new work package is created and connected to the two others.
 This same mechanism is available for other objects, for example to 
create a message between two org-units, two operations, two 
applications, etc., in MEGA Process and HOPEX Architecture.

Specifying work package composition

To specify work package comosition:
1. Select View > Views and Details. 
2. In the dialog box that opens, select the Composition check box, then 

click OK.
3. Draw a link between two sub-projects.

The Create link dialog box appears.

It offers a choice between a "Next Project" link which indicates a sequence
between two projects, and a "Project Step" link which indicates that one
project is a step to be carried out in another.

4. Select the "Project Step" link. A dotted arrow line is displayed between 
the two projects.

 An alternative approach to specifying project composition is via 
New > Sub-Project.
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CREATING TOGAF 9 WORK PACKAGE DOCUMENTATION

HOPEX Suite for TOGAF can be used to create the deliverables of the work
package, as it progresses. This ability is based on two main features of the HOPEX
platform:

• The Help integrated in the projects through MOKA. 
• The book concept, which allows users to easily create documents 

consisting of text, diagrams and reports. The result can be used to 
generate documents in RTF or PDF format.

 This feature is only available with the HOPEX Productivity Pack 
product.

Accessing Help at Each Work Package Stage

Work Package recommendations

In the Work Package editor or in the Work Package properties dialog box, you can
obtain help at any time when this is linked to a phase and/or method.

Explanations are provided as a function of the method and/or phase indicated in the
work package properties dialog box. These explanations appear in the Method tab.
The information provided include explanations as to the deliverables that should be
produced and the skills required.
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When you modify methodological type information concerning the work package (its
method or phase for example), this tab is automatically updated.

Creating Deliverables Relating to the Work Package

Instances of work package deliverables can be created from templates attached to
deliverables of the different phases. 

 A deliverable is an element produced, modified or used by a phase 
or method (example:

Deliverables related to the project can be of different types: Report, Document,
Book, Diagram or External Reference. 

 For more details on phase deliverables, see "Deliverable 
properties", page 24.

You can create documents associated with each stage of your project from the
Method tab of each sub-project.

To access the different deliverables:
1. Open the properties dialog box of the sub-project and select the Method 

tab.
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2. In the "Deliverables" section of the page, click button  to create an 
instance of the deliverable template.
The instance appears in the page and the template is selected. 

Deliverables relating to a work package are automatically classified in the Contents
folder of the work package. 

You can create deliverables:
• From the Method tab of the work package.
• Via the pop-up menu of the work package by selecting the specific 

command.

Creating external references

HOPEX enables association of external references with your project, based on those
that exist for deliverables. External reference templates are proposed as a function
of the method or phase selected for the project.

If your project is linked to a method or phase itself linked to an external reference,
you have access to a menu that allows you to create an external reference specific
to your project.
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To create an extarnal reference for a work package:

1. In the "Deliverables" section of the page, click the  button to create 
an instance of the external reference.
A list of available documents is proposed as a function of the selected
method and phase.

2. Select an external reference and click OK.
3. Select a folder in which to place the copy of this document and click OK.

A copy of this document is placed in the folder that you indicated. The
project external reference is created.

You can double-click on the document and modify it.

Creating a document 
HOPEX advises you in the choice of documents to be generated as a function of the
phases connected to your work package. 

As an example, the Method tab of the "Identify problems in the process" sub-
project proposes that you generate a document concerning business processes.

To generate this document:

1. In the "Deliverables" section of the page, click button  to create an 
instance of the document.
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2. Select the document template that you wish to use.

3. Click OK.
4. Then select the object to be described in the document template.

5. Click OK.
The document based on the selected document template appears in the
navigator.

6. Double-click the document to start its generation.

Creating diagrams

HOPEX offers the possibility of creating a diagram relating to the work package,
that is to produce a deliverable in the form of a diagram.
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Creating Reports

Reports can be created as deliverables in relation to work packages that are
required to produce deliverables in the forma of reports.

To create a report:
1. Open the Properties dialog box of a work package.
2. Click the Method tab.

In this tab, a definition of the phase is displayed along with the
requirements of the phase.
A list of the required deliverables of the phase and the types of objects
that support these deliverables is also displayed in a matrix. 

3. To craete a deliverable that can be supported by a report, in the 

Template tab, click the New buttone  next to the report template.

4. If you wish to set the different parameters for the report, click Next and 
follow the instructions of the creation wizard, if not, click Finish.
The new report appears in the Instance column of the matrix.

TOGAF Books

The use of books simplifies collaborative work by offering possibilities of adding
notes in paragraphs, by enabling automatic update of inserted components, and
management of access to objects currently being modified. In addition, books use
the capacities of HOPEX to manage several languages.

Accessing TOGAF 9 book templates

In order to create instances of deliverables, HOPEX Suite for TOGAF has
integrated a documentation structure based on books. These book instances are
created from TOGAF 9 book templates. 

The TOGAF 9 book templates are only available if the "TOGAF 9 - Data" add-on has
been imported.

 Templates must not be modified by the Project Manager! Only 
instances of books should be modified.

A book is built using chapters and paragraphs. A book can also reference another
book or reports. 

The structure of a TOGAF 9 book is accessible from the TOGAF 9 navigation
window.
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To view a book and its component elements:
1. Expand the Book Templates folder.

The following window appears on the left of your workspace.

The text content of a chapter is defined in paragraphs. This content can be a text,
a diagram, an object or an external reference.

Viewing the content of a book or chapter

Structuring in chapters and paragraphs enables flexible organization of
presentation.  HOPEX objects of different types can be dragged into the book,
content of which is automatically updated.

The content of a book or chapter is visible in its properties dialog box.

To view the content of a chapter:
1. Click the chapter in the navigation tree.

2. Then click the Properties button  in the toolbar of the workspace.
A properties window appears.

 To simplify your work, position the properties window in the central 
part of the edit area by right-clicking the window title bar and selecting 
Integrate in Edit Window.
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3. Select the Properties window and select the Documentation Report 
tab to view the text of the chapter.

 To avoid long display times, diagrams are replaced by a standard 
image. You can display the diagram by clicking its image.

 To view all diagrams and reports contained in a paragraph, click the 

Expand All button on the right 
 To view a report inserted in a book, click the Display Report 
button on the right 

Using books 

In HOPEX Suite for TOGAF, book templates are delivered with standard structure.
A book, attached to a work package, can be enriched with new elements.

To create a book from a book template:
1. Open the properties dialog box of the work packageand select the 

Method tab.

2. In the "Deliverables" section of the page, click button  to create an 
instance of a book template.
The instance appears in the page and the template is selected. 
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A new book is automatically classified in the Contents folder of the work package.
You can expand the book to see the chapters.

Accessing the content of a paragraph

From the properties window of a book or chapter, it is possible to access objects
contained in paragraphs.

To access a diagram or the objects it contains:
1. Click the diagram so that its components are displayed.
2. Right-click any component to open its pop-up menu and access its 

characteristics.

To access the text of a paragraph from the Documentation Report tab of the
properties window of a chapter or book:

1. Click the Edit  button on the right of the paragraph that interests 
you.
The properties dialog box of the paragraph opens.

2. Select the Characteristics tab to access the text of the paragraph.
3. Modify the existing text.

 Note that the Comment area proposes features similar to those of 
MS Word, including a spelling checker.

4. Click OK.

Connecting objects to a paragraph

Several types of objects can be connected to a paragraph:
• Diagrams
• External references
• Objects

You can use the Connect command in the paragraph pop-up menu to connect new
objects.

 It is also possible to connect an object to a paragraph by selecting 
the object and dragging it to the target paragraph.



44 HOPEX for TOGAF

3

The list of elements referenced in a paragraph is available from the navigation tree
of the book.

An alternative method of access to all objects referenced in a paragraph:
1. Open the properties dialog box of the paragraph and select the Objects 

linked for documentation tab.
2. Use the Connect or Reorganize buttons to modify paragraph content.

You can view the result of your modifications by selecting the
Documentation Report tab.

3. Click OK to finish. 
 The sections Included System Diagram and Mentioned Object 
System enable referencing of system objects such as descriptions, 
document templates and queries.
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MEGA ADVISOR WEB SITE

HOPEX Advisor is a ready-to-use web application giving dynamic access to HOPEX
repositories via the Internet. It addresses the major domains of enterprise
architectures (strategy, operational, system, technical).

As a standard, HOPEX Advisor is provided with a set of roles which limit web site
content to the scope of interest of the reader. In order to allow a TOGAF expert to
retrieve the architectures designed in a HOPEX repository, a TOGAF role is
introduced. It gives quick access to all the architectures as entry points.
A page dedicated to the TOGAF architectures details all the products and shows
entry points to the reports corresponding to these products.

Using the MEGA Advisor Web Site

 Before the TOGAF expert can reap the full benefits of working with 
the HOPEX Advisor web site and be able to manipulate all the TOGAF 
affiliated objects, this web user must have "Expert" level access.

To access HOPEX Advisor:
1. Log in to HOPEX Advisor with the appropriate user and password.

The information displayed on the Home page corresponds to the role
defined for the connected user.

2. In the main menu, pass the pointer over Architectures and click 
TOGAF Architectures.

The repository and the repository objects to which the user has access are visible.
Your repository must have information in it for you to visualize anything.

You can also gain access to the main objects of the repository via their own menus.

For example, to view Work Packages.
For further information on using HOPEX Advisor, see the HOPEX Advisor user 
guide.
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METAMODEL CUSTOMIZATION

It has been proven that difficulties arise when the TOGAF application is used with a mixture of both
TOGAF and HOPEX vocabulary. These difficulties are perceived in the TOGAF navigation tree which
uses TOGAF vocabulary while created objects have HOPEX metaclass names.

To bridge the gap between both worlds (HOPEX and TOGAF) and simplify the appropriation of the
TOGAF application by a TOGAF expert, the HOPEX metamodel has been translated and the notions
used renamed. 

This section therefore details the mapping made between the HOPEX and TOGAF concepts used.
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MEGA METAMODEL CUSTOMIZATIONS

This section indicates the concepts relating to TOGAF and the HOPEX concepts used
to implement them. 

The table below lists the concepts renamed with their standard definition (from the
HOPEX perspective) and the TOGAF definition. The aim of this renaming is to make
the mapping between the TOGAF concepts and the HOPEX concepts as invisible as
possible for the user. 

MEGA Concept TOGAF Concept Initial MEGA Defi-
nition TOGAF Definition

Business Function Role A business function is 
a skill or grouping of 
skills of interest for 
the enterprise.

The usual or expected 
function of an actor, or 
the part somebody or 
something plays in a 
particular action or 
event. An actor may 
have several roles.

Fucntionality Functional Behavior A functionality is a 
service required by an 
org-unit in order to 
perform its work. This 
functionality is gene-
rally necessary within 
an activity in order to 
execute a specific ope-
ration. If it is a sof-
tware functionality, it 
can be provided by an 
application.

Defines the behavio-
ral characteristics of 
an architecture item. 

Site Location A site is the geogra-
phical location of an 
organization. Exa-
mples: Boston subsi-
diary, Seattle plant, 
and more generally 
the headquarters, 
subsidiaries, plants, 
warehouses, etc. 

A place where 
business activity takes 
place and can be hie-
rarchically decom-
posed.
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Package + Data Model Logical Data Compo-
nent

A package partitions 
the domain and the 
associated work. It is 
used to organize ele-
ments into groups, 
particularly use cases 
and classes. Packages 
may be nested within 
other packages. Pac-
kages are linked by 
contractual rela-
tionships that define 
their interface.

A data model is used 
to represent the static 
structure of a system, 
particularly the types 
of objects manipulated 
in the system, their 
internal structure, and 
the relationships 
between them.
A data model is a set 
of entities with their 
attributes, the asso-
ciations existing 
between these enti-
ties, the constraints 
bearing on these enti-
ties and associations, 
etc. 

A boundary zone that 
encapsulates related 
data entities to form a 
logical location to be 
held. For example, 
external procurement 
information.

IT Service Platform Service An IT service is a com-
ponent of an applica-
tion that is available to 
the end user of the 
application. 
IT services are the 
breakdown of an 
application into its 
basic functional units. 
An IT service is a 
consistent, indivisible 
unit of processing that 
coordinates a set of 
messages and events 
in order to perform a 
task in the information 
system. In the appli-
cation architecture, 
the IT service is the 
most basic functional 
unit.

A technical capability 
required to provide 
enabling infrastruc-
ture that supports the 
delivery of applica-
tions.

MEGA Concept TOGAF Concept Initial MEGA Defi-
nition TOGAF Definition
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Some HOPEX concepts were already renamed in the HOPEX application to be used
strictly in the TOGAF 9 context. For compatibility with TOGAF 9, these concepts were
again renamed.

The table below lists the HOPEX-adapted TOGAF concepts that were renamed for
compatibility purposes. They are presented with their definition.

Project Work Package A project consists in a 
set of tasks entrusted 
to a team that trans-
forms a system, or 
part of a system, in 
order to achieve a 
specific objective.

A set of actions identi-
fied to achieve one or 
more objectives for 
the business. A work 
package can be a part 
of a project, a com-
plete project, or a pro-
gram.

MEGA Concept TOGAF Concept Initial MEGA Defi-
nition TOGAF Definition

Previous TOGAF 
Concept

New TOGAF 
Concept TOGAF Definition

T9 Event Event An organizational 
state change that trig-
gers processing 
events; may originate 
from inside or outside 
the organization and 
may be resolved inside 
or outside the organi-
zation. 
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T9 Function Function Delivers business 
capabilities closely 
aligned to an organi-
zation, but not neces-
sarily explicitly 
governed by the orga-
nization. Also referred 
to as "business func-
tion".

Enterprise Goal Goal A high-level statement 
of intent or direction 
for an organization. 
Typically used to mea-
sure the success of an 
organization. 

T9 Process Process A process represents a 
sequence of activities 
that together achieve 
a specified outcome, 
can be decomposed 
into sub-processes, 
and can show opera-
tion of a function or 
service (at next level 
of detail). Processes 
may also be used to 
link or compose orga-
nizations, functions, 
services, and pro-
cesses.

Previous TOGAF 
Concept

New TOGAF 
Concept TOGAF Definition
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